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Introduction 

The TCEQ contracted with ERG to develop the TexN model, a tool for estimating Texas-
specific emissions from nonroad mobile sources, excluding commercial marine vessels, 
locomotives, and aircraft. The TexN model uses EPA's Nonroad model to calculate 
emissions, as previously required by the EPA for developing emissions estimates for 
state implementation plan revisions, national emissions inventories, and reasonable 
further progress (RFP) analyses. Since TexN was developed, the TCEQ has frequently 
updated the Texas-specific data within the tool and enhanced the tool's functionality. 

In 2014 the EPA first integrated the Nonroad model into the MOVES2014 model. The 
EPA now requires states to use the most recent version of the MOVES model (currently 
MOVES3.0.1 but subject to update) when developing and submitting emissions 
estimates from specific nonroad mobile sources to the EPA. The TCEQ contracted with 
ERG to develop a successor to TexN, called TexN2, to assist the TCEQ with the 
transition to the most recent version of the MOVES model. 

TexN2 facilitates the generation of MOVES-Nonroad county databases (CDBs) based on 
the extensive Texas-specific data developed for TexN; automates execution of MOVES-
Nonroad runs using these CDBs; compiles results from the MOVES-Nonroad runs; 
applies post-processing adjustments; and generates reports in a variety of output 
formats.   

 

Figure 1. Overview of TexN2 data flow 
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Setting up TexN2.2 

This section describes setting up TexN2.2 for the first time on a computer.  If the user 
already has prior versions of TexN2 on the computer, you may want to additionally refer 
to “Migrating from TexN2 earlier versions” later in the document.   

MOVES Versions 

TexN2.2 requires that MOVES3 be installed to operate correctly and will not work with 
prior versions of the MOVES model including MOVES2014b.  However, prior versions 
of MOVES do not cause any conflicts, and therefore may be optionally left on the user’s 
machine.  Should the user wish to remove prior versions of MOVES, ERG recommends 
first trying to use the uninstaller tool that comes with some older versions of MOVES, 
accessible through the start menu as shown below for MOVES2014a.   

 

If there is no start menu “Uninstall” option for your version of a prior MOVES model, 
open the computer settings (Start menu > Gear box icon > Apps > Apps & features) and 
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scroll down through the applications to the MOVES version you wish to uninstall, as 
shown below.  

Note: the user may also need to navigate to the MOVES folder (C:\Drive > Users > 
Public > EPA > MOVES) to check for additional folders associated with the prior 
version(s) of the MOVES model that the “Uninstall” option may not remove. Those 
items may need to be deleted manually. 

 

System requirements 

TexN2 was developed for use with computers running a 64-bit Windows operating 
system. It was developed on Windows 10, but there are no known incompatibilities with 
Windows 7, and it is likely to be compatible with future versions of Windows. TexN2 
should run effectively on any machine that is capable of running MOVES. MOVES-
Nonroad outputs can require tens of gigabytes of storage space, so it is recommended 
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that the availability of ample storage space on the drive containing the MySQL data 
directory be confirmed prior to running a TexN2 scenario. 

Prerequisites  

TexN2.2 requires the latest version of MOVES3 (currently MOVES3.0.1), which can be 
found here: https://www.epa.gov/moves/latest-version-motor-vehicle-emission-
simulator-moves. The MOVES3 installer verifies that an appropriate version of 
MariaDB is installed on the machine. If needed, it will automatically install a compatible 
version of MariaDB. This user's guide also assumes that HeidiSQL (graphical user 
interface for MariaDB that replaces MySQL Workbench) is installed.  HeidiSQL is 
automatically included in the MOVES3 installation.  ERG highly recommends keeping 
“MySQL Workbench” installed on your machine as it contains a convenient option to 
batch delete many databases (i.e., complete TexN2 scenarios that the user no longer 
needs). HeidiSQL does not allow batch deleting of databases. This topic is mentioned 
again in the later section “Managing TexN2 and MOVES-Nonroad databases.” 

Background Information on MariaDB vs. MySQL 

MariaDB is a community-developed and commercially supported fork of the MySQL 
relational database management system.  MOVES3 moved to using MariaDB server, 
whereas MOVES2014b used MySQL server.  The database query language is still 
referred to as “MySQL” in both software systems.  Throughout this User Guide, we strive 
to use the name “MySQL” only when referring to the database language.  Know that 
MySQL still refers to MariaDB which is required for use of MOVES3 and therefore 
TexN2.2.  The table below lists the terminology side by side. 

 MOVES2014b MOVES3 
Software database server 
included with EPA 
MOVES model 

MySQL Server 5.7 MariaDB Server 10.4 

Database GUI MySQL Workbench HeidiSQL 
Database language MySQL MySQL 

 

 

Note: users who have been running MOVES2014b or earlier may also have MySQL 
installed on the computer.  Having both MySQL and MariaDB on the same computer 
should not cause any problem.  When MySQL is already present, the new MariaDB 
installation will automatically select a different port number than the one occupied 
by MySQL. It is important to know your MariaDB port number for the initial setup of 
TexN2.2.  To find your MariaDB port number, the simplest way is to check the 
MOVES3 installation directory.  By default, the directory is 

https://www.epa.gov/moves/latest-version-motor-vehicle-emission-simulator-moves
https://www.epa.gov/moves/latest-version-motor-vehicle-emission-simulator-moves
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C:\Users\Public\EPA\MOVES\MOVES3.0. Open the file MySQL.txt, and the 
number inside on line 1 is your MariaDB port number.  If MySQL.txt does not exist 
in your MOVES installation directory, then your MariaDB port number is 3306.  

Important: The US EPA installer for MOVES3 automatically installs MariaDB.  During 
the MariaDB installation process, you will be asked to set a MariaDB root user 
password.  Write this password down; it is not recoverable later.   

Configuring the “moves” user  

TexN2 is designed to not require an installer, so there are a few manual steps that must 
be performed prior to launching the utility for the first time.   TexN2 requires a 
MariaDB/MySQL user with “SUPER” privileges.  We recommend configuring the 
specific user “moves” to add these privileges and always using the “moves” user to run 
TexN2. The MOVES3 installation automatically creates  this “moves” user. 

First, launch HeidiSQL: 

 

Click on a connection and log in.  The MOVES3 installer should have set up a 
connection named “MOVES Connection” for the MariaDB port (3307 in the image 
below, but your port number may be different).    
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Important: For this particular log-in session, update the user to “root” and the root 
user password you set earlier during the MariaDB configuration during the MOVES3 
installation.    

The screenshot below has custom connection name set up “Local DB host MariaDB.” 
Unless you already have custom connections setup, select the “MOVES Connection”, 
change the user to root, enter the root password, then click Open.   

 

 

 

After logging in, you should see a screen similar to the image below. On the left are the 
MySQL databases currently on the machine and on the right is a workspace where you 
can execute MySQL queries.  On the top menu bar, select Tools > User Manager.  
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In the User Manager, follow the directions below. They’re shown in numbered steps, 
then repeated overlaid onto a screenshot of the User Manager. 
  

1. Select “moves” user so the manager highlights it in grey.   
2. Then provide the Password and Repeat password. 
3. Click the dropdown next to Global privileges and  
4. scroll all the way down to “SUPER” 
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5. Check SUPER  
6. Click Save. 

 

1 2 

3 
4 

5 

6 



 

11 

 
Important: Repeat steps 1-6 for all “moves” users, if more than one exists in your 

HeidiSQL User Manager list. 
 

Close out of the User Manager when finished updating the moves user privileges. 

 

Remove Remnants of the Prior Utility 

If you created a TexN2 shortcut associated with the old utility, navigate to it, Right-click 
and select “Delete.”   If you have a prior TexN2 database already in your MariaDB data 
directory delete it using HeidiSQL as shown below.  Note:  you may not have a prior 
TexN2 database.  If there is no TexN2 database, skip this step and proceed to 
“Importing the TexN2 database.”  Otherwise, Right-click on TexN2 in HeidiSQL and 
select the option “Drop” as shown below. 

Configuring MySQL Workbench to Connect to MariaDB  

The Prerequisites section of this User Guide recommends keeping MySQL Workbench 
on the user’s computer for the convenient feature of batch deleting many databases at 
once.  To use this feature, a new connection will need to be added to MySQL 
Workbench.  First, make note of your MariaDB port number (see Prerequisites section).  
In the example in this section, the MariaDB port number is 3307.  Second, open MySQL 
Workbench from the start menu.  The welcome screen of MySQL Workbench shows all 
existing connections.  In the screenshot below, all connections are to port 3306 (and 
correspond to MySQL Server 5.7).  Next, add a new connection for port 3307 
(corresponding to MariaDB 10.4). 
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Click the plus icon adjacent to MySQL Connections.  This will launch a pop up window 
titled, “Setup New Connection.” 

Note that all existing connections are to port 3306.  
A port for 3307 will need to be added. 
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Optionally, add a Connection Name (ERG recommends MariaDB for clarity).  Change 
the port number to your actual MariaDB port number (3307 in this example). Change 
the Username to “moves” and click “Store in Vault” adjacent to password to set the 
password.  In the Password pop up box, set the password to “moves” without the 
quotation marks. 
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After entering the password, click OK in the Store Password for Connection box.  Back 
in the main “Setup New Connection” Window, click “Test Connection” and then 
“Continue Anyway” for the warning box. 
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If the connection is successful, you should see a confirming message similar to below. 
Click OK. 
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Click OK on the success message box and OK again to close the Setup New Connection 
box.  You should see a new connection appear on the MySQL Workbench welcome 
screen.  Click on that new connection anytime you wish to log in and batch delete 
multiple databases associated with one or more TexN2.2 scenario runs. See the later 
section “Deleting database” for more information. 
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Importing the TexN2 database 

The next manual step that must be performed prior to launching the utility for the first 
time, is to import the TexN2 database using HeidiSQL. The database file should have 
been provided with the utility, and will have a name like TexN2_*.sql, where "*" is a 
date stamp.  
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From the File menu at the top of the HeidiSQL screen, choose "Load SQL file": 
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Navigate to the TexN2 database file (TexN2_*.sql) and select it and click Open: 
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You may see a warning that you are opening a large file. Select “Run file(s) directly 
without loading into the editor.” 

 

 

Now wait for the data import process to complete. This can take a while (around 30 
minutes), so be patient.   
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Right-click on your connection name and select refresh to verify that the database has 
been imported. If it has been imported successfully, you should see "texn2" listed in the 
left-hand pane: 

 

After the database import completes, you are ready to launch TexN2.2. 
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Creating a shortcut to TexN2 

Since TexN2 is designed to work without an installer, it is launched by directly double-
clicking the executable file, texn2.exe. However, the executable resides in a folder along 
with a number of other required files, so it is strongly recommended to create a shortcut 
to the TexN2 executable to avoid the need to open the containing folder to launch the 
utility; any manipulation of files in this directory runs the risk of deleting or corrupting 
files that the utility requires to function properly. Creating a shortcut will also make 
launching the utility more convenient. The contents of the folder containing the 
executable will resemble the image below:  
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Find the texn2.exe file in the folder, right click, and choose "Create Shortcut": 
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Find the shortcut that was created and drag it to the Desktop or other convenient 
location: 
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Graphical User Interface overview 

MySQL credentials dialog 

The first time you launch TexN2, it will display a dialog box requesting your MySQL 
username and password and the “MOVES port” which MariaDB uses. Enter lower case 
“moves” and “moves” for the MySQL user and MySQL password, and enter your 
MariaDB port number (if uncertain, refer to Prerequisites of this user’s guide). This 
information can also be updated on the Run tab of the Graphical User Interface (GUI).  

 

There is a long text note in the MySQL credentials box about two separate issues.   

First, TexN2 will look for the latest version of the MOVES default database on 
your machine.  For example, if you have both MOVES databases movesdb20201105 and 
movesdb20210209, TexN2 will connect automatically to the latter.  The MOVES default 
database may be changed in the Run tab of the GUI.  Subsequent launches of TexN2 will 
remember and quickly connect to the most recent MOVES database used. During the 
first launch of TexN2.2, may take up to a minute for the utility to find the MOVES 
database.   

The second issue is meant to alert the user to verify the “MOVES install path” in 
the Run tab after the first launch, because the utility may remember the MOVES install 
path for MOVES2014b for the initial launch.  Users should check the Run tab of the 
TexN2 GUI and ensure the MOVES install path gets changed to MOVES3. Subsequent 
launches of TexN2 will remember the MOVES3 installation path.  TexN2.2 will not run 
with MOVES2014b. 
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Scenario tab 

A TexN2 scenario is an individual project specifying runs for a particular scenario year, 
one or more counties, and one or more equipment types. The first tab of the GUI allows 
the user to specify high-level details about the scenario: 
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• Scenario name: a short, descriptive name for the scenario. This name will be 
used as the scenario's database name, so there are certain restrictions that are 
automatically enforced. For example, the name cannot start with a number, and 
special characters are prohibited; these are replaced with an underscore when 
the database name is derived from the scenario name. Therefore, to avoid 
confusion, it is recommended that you use scenario names without a number in 
the first position, without spaces, and containing only alphanumeric characters 
or underscores. 

• Output directory: this is the root location where output files generated for the 
scenario will be stored, e.g., reports and CDBs. A subfolder under the output 
directory will be created using the scenario's name (after leading digits and/or 
special characters are removed). Note: Click on “Browse” and go to dist> 
TEXN2> data and create a new folder and name it the same as the “Scenario 
name” you just created and select that folder for your Output directory. You will 
complete this process for each unique Scenario.  

• Scenario year: the calendar year to be modeled. 

• Met year: the meteorological year data that should be used. TY stands for a 
"typical year" representing typical values for minimum temperature, maximum 
temperature, average temperature, and relative humidity. 

• Period: the period of time to be modeled, either annual (tons per year), spring, 
fall, summer, winter, ozone season day (tons per day) - weekday, or ozone season 
day - weekend. Note: typically use either “Annual” or “Ozone Season Day- 
Weekday”. 

• Author name: this field is optional and is used only for XML reports. It specifies 
the information that will be entered into the AuthorName field of the XML 
report. Note: Complete this information for any scenario runs that will be used to 
develop XML files for upload to TexAER or to the EPA EIS Gateway.  

• Author contact information: this field is optional and is used only for XML 
reports. It specifies the information that will be entered into the SenderContact 
field of the XML report. Note: only up to 200 characters are allowed in this text 
box, and most special characters are prohibited. Special characters and 
characters beyond the 200-character maximum are ignored. Note: Complete 
this information for any scenario runs that will be used to develop XML files for 
upload to TexAER or to the EPA EIS Gateway. 
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• Author e-mail: this field is optional and is used only for XML reports. It specifies 
the information that will be entered into the UserIdentifier field of the XML 
report. Note: Complete this information for any scenario runs that will be used to 
develop XML files for upload to TexAER or to the EPA EIS Gateway. 

• Comments: this field is optional and is used only for XML reports. It specifies the 
information that will be entered into the SubmittalComment field of the XML 
report. Note: only up to 200 characters are allowed in this text box, and most 
special characters are prohibited. Special characters and characters beyond the 
200-character maximum are ignored. Note: Complete this information for any 
scenario runs that will be used to develop XML files for upload to TexAER or to 
the EPA EIS Gateway. 

File menu 

The File menu allows the user to save a scenario or open an existing scenario. Before 
saving a scenario, all of the basic information required for a scenario must have been 
entered already, such as the scenario name, region(s), source type(s), etc. 
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About menu 

The About menu displays basic version information about TexN2. 
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Controls tab 

The Controls tab is where selections related to post-processing, fuels, and emission 
standard selections are made for the scenario. 

 

• Post-process and Fuels 

o Altitude: enable/disable altitude post-processing adjustments. 

o Ground cover: enable/disable ground cover post-processing adjustments. 

o Soil: enable/disable soil post-processing adjustments. 

o Temperature and humidity: enable/disable climate post-processing 
adjustments. 

o TxLED: enable/disable Texas Low Emission Diesel post-processing 
adjustments. 

o Reformulated gasoline: enable/disable reformulated gasoline. If 
reformulated gasoline is disabled, fuel properties for certain counties with 
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reformulated gasoline (RFG) will be replaced with fuel properties from 
neighboring counties. 

• Emissions technology and RFP analysis 

o Max technology year: if "None" or a technology year later than the 
scenario year is chosen, all available emissions standards will be applied. If 
a max technology year before the scenario year is selected, technologies 
introduced after the max technology year will be excluded from the 
scenario. 

o Enable all rules: all federal and state rules affecting nonroad emissions are 
enabled. Selection of this radio button automatically deselects any 
uncontrolled or controlled options that may have been selected, i.e., they 
are mutually exclusive. 

o Uncontrolled and Controlled radio buttons for individual rules (i.e., Small 
spark ignition - Phase 1 through Small SI/SI marine): specify whether the 
particular rule should be in effect (Controlled) or not (Uncontrolled). The 
rules are listed in order of their introduction, so selecting either 
Uncontrolled or Controlled for a particular rule implies that all previous 
rules are in effect. Only one of these buttons can be selected at a time, and 
they are mutually exclusive with the "Enable all rules" selection.  

Note:  

To perform a “Fully Controlled” run: 

• Enable (check) all the boxes in the Post-process and Fuels section of this tab. 

• Set the Max Technology Year to the current scenario year (“Enable all Rules” will 
automatically be enabled).  

 

To perform a “Fully Uncontrolled” run: 

• Enable (check) only the Altitude, Ground cover, Soil, and Temperature and 
Humidity boxes in the Post-process and Fuels section of this tab. Do not enable 
(check) the TxLED or Reformulated gasoline boxes.  

• Select the “Small spark ignition - Phase 1” Uncontrolled radio button  
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Region tab 

The Region tab is where the counties of interest are selected for the scenario. The 
pulldown menu at the top of the screen allows the user to select a county group, which 
limits the selection options to a subset of counties. 

 
 

• Add selected: add the counties highlighted in the left pane to the list of selected 
counties in the right pane. 

• Select all: highlight all counties in the left pane. 

• Remove selected: remove all counties highlighted in the right pane. 

• Remove all: remove all counties from the right pane. 

• Create county group: create a new county group based on counties currently 
listed in the right pane. This button will bring up a dialog box allowing the name 
of the county group to be specified (see screenshot below). New user-defined 
county groups will be added to the bottom of the pulldown menu. 

• Delete user county groups: remove all user-defined county groups, reverting to 
just the county groups defined in the default TexN2 input database. 
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Sources tab 

The Sources tab is used to specify the equipment types to be included in the scenario. 
The top half of the tab includes three levels of filtering (Fuel types, Classification, and 
Subsector) to allow the user to limit the list of options shown in the Available pane in 
the lower half of the tab. Flow is from left-to-right and top to bottom: first, select a Fuel 
types filtering option, then a Classification filter, then a Subsector filter, and then choose 
from the equipment types shown in the Available pane to add them to the Selected pane. 

 
 

• Aggregate DCE subsectors: If this checkbox is selected, the population and 
activity data for the DCE subsectors will be aggregated to the SCC level using 
population-weighted averages. Note: because of model year distribution effects 
that cannot be accurately captured at the SCC level, this selection should be used 
with caution. Emissions estimates generated using an aggregated equipment 
fleet will not match estimates generated for equipment disaggregated by DCE 
subsector. 

• Fuel types: filter the available equipment types by fuel type. Select All to disable 
filtering by fuel type. 
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• Classification: filter the available equipment types by classification. Select All to 
disable filtering by classification. 

• Subsector: filter the available equipment types by DCE subsector. Select All to 
disable filtering by subsector. 

• Available: displays the list of available equipment types after filtering is applied. 

• Add selected: add the equipment types highlighted in the Available pane to the 
list of equipment types in the Selected pane. 

• Select all: highlight all of the equipment types shown in the Available pane. 

• Remove selected: remove the equipment types highlighted in the Selected pane. 

• Remove all: remove all equipment types from the Selected pane. 

 

Note: For a scenario run in which you want to calculate all Nonroad emissions: 

• Leave the “Aggregate DCE Subsectors” disabled (unchecked) 

• Under Fuel Types, select All 

• Under Classification, select All 

• Under Subsector, select All 

• In the “Select” section, click “Select All” and then click “Add Selected” 

At the time of writing (April 2021), the MOVES model does not have the capability of 
applying different scrappage to different SCCs within a single MOVES run.  Prior to 
TexN2.2, the limitation dictated that the user must run TexN2 in three separate parts to 
isolate two SCCs from the rest of the equipment.  This user action is no longer required 
as of TexN2.2.  The utility automatically handles the MOVES run isolation and ensures 
the applicable alternative scrappage curve is applied to diesel agricultural tractors and 
diesel skid steer loaders.  

 
Tip: When working from saved versions of .JSON files, double-check the intended 
selections on the Controls tab (e.g., in order to execute TxLED adjustments).  These 
selections are not saved as part of the .JSON file; rather they refer to a TexN2 
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configuration file that changes according to the most recent run performed.  Please 
ensure these selections are correct in the current run before executing. 
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Edit tab 

The Edit tab allows the user to make limited changes to the default TexN2 input data. 
Large-scale changes, e.g., replacing the data in an entire table, should be done by 
specifying an alternate input database in the Input databases tab. 

The first pulldown menu on this tab specifies the county, and the second pulldown 
menu filters the activity and population tables by SCC to make it easier to find and edit 
the data for a particular county and equipment type. The third pulldown menu 
determines which data are shown in the table editor: fuels, climate, population, or 
activity. The white cells in the table are editable and the blue cells are read-only. The 
"Reset to default values" button will remove all user edits for the given data type (fuels, 
climate, population, or activity). 

Note: edits to the tables are restricted to numeric data and are also subject to the 
range restrictions listed below. Inputs of non-numeric data or values outside of these 
ranges are ignored. 

• fuels 

o gasRVP: 6-15 

o oxygenWtPct: 0-5 

o gasSulfur_pct: 0-0.08 

o dieselSulfur_pct: 0-0.5 

o marineDslSulfur_pct: 0-0.5 

o CNG_LPGsulfur_pct: 0-0.004 

• climate 

o minTemp: -50 - 200 

o maxTemp: -50 - 200 

o avgTemp: -50 - 200 

o relHumidity: 0-100 

• activity 

o activityLevel: zero or greater 
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• population 

o avgHP: zero or greater 

o population: zero or greater 
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Input databases tab 

The Input databases tab allows for the selection of databases containing tables that will 
supersede entire tables in the default TexN2 input database. It also allows the user to 
specify databases containing tables completely or partially overriding the default 
MOVES input data (see the MOVES user guides for more information about the Manage 
Input Data Sets feature; tables selected on this tab are passed through to MOVES and 
treated just as if they were selected using the Manage Input Data Sets feature in 
MOVES). 

 
 

• Refresh: refresh the list of available databases. The lists of databases in the upper 
and lower halves of the pane are identical; they are duplicated for convenience. 

• Add selected: add the database highlighted in the left pane to the list of selected 
databases in the right pane. 

• Remove selected: remove the highlighted database from the right pane. 

• Remove all: remove all databases from the right pane. 
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• Move up: move the highlighted database up in the replacement sequence. If the 
same table exists in multiple selected databases, the database that occurs lowest 
in the list will take precedence. 

• Move down: move the highlighted database down in the replacement sequence. 
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Run tab 

The Run tab contains the controls to launch the current scenario. In typical use, the 
"Run all steps" button is used to initiate the entire sequence of steps required to execute 
the scenario, from creating the CDBs and runspecs for the MOVES-Nonroad run to 
post-processing the outputs.  

On occasion, however, it may be useful to manually initiate the various steps. For 
example, you may want to just create the runs (step 1) so you can inspect the CDBs and 
runspecs generated by TexN2 before launching the MOVES-Nonroad runs. After 
inspecting the MOVES-Nonroad inputs, you could then manually trigger the execution 
of the runs (step 2), compile the MOVES-Nonroad outputs into the main scenario 
database (step 3), and then post-process the outputs (step 4). 

There are also two buttons that automate specific analyses. The "Run complete RFP 
analysis" button launches a sequence of runs using the entire progression of federal and 
state rules shown on the Control tab. For more detailed guidance on using this function, 
see the automated RFP analysis section below. The "Generate CDBs for NEI" button 
generates a single CDB per county that matches EPA’s naming conventions and 
requirements.  They should pass all quality assurance (QA) checks required by U.S. 
EPA’s Emissions Inventory System (EIS) for nonroad submittals for AERR/NEI.   
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• Additional pollutants: select additional pollutants, beyond the basic criteria 
pollutants. In MOVES, pollutants have chained dependencies on other pollutants, 
meaning that certain pollutants can only be calculated if certain other pollutants 
are calculated. Therefore, the additional pollutants in TexN2 are automatically 
applied sequentially, i.e., selection of a particular group of pollutants 
automatically selects all of the preceding pollutants, and deselection of a group of 
pollutants automatically deselects all succeeding pollutants. 

• Run all steps: automatically run all of the steps required to execute the scenario, 
from creating the MOVES-Nonroad CDBs and runspecs to post-processing the 
outputs. 

• Export CDBs: enables automatic exporting of all CDBs generated for the scenario. 
The CDBs are stored in the scenario's output folder within the output directory 
specified on the Scenario page of the GUI. The exported CDBs can be imported 
into MariaDB on any machine using a process similar to the TexN2 database 
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import steps described previously in the Importing the TexN2 database section 
of this document. 

• 1: Create runs: manually initiate just the first step in the execution of a scenario, 
creating the MOVES-Nonroad CDBs and runspecs. 

• 2: Execute runs: manually initiate the second step in the execution of a scenario, 
executing the MOVES-Nonroad runs. Step 1 must have already been successfully 
completed. 

• 3: Compile output: copy the data from the individual MOVES-Nonroad output 
databases into the main scenario database. Steps 1 and 2 must have already been 
successfully completed. 

• 4: Post-process: apply all of the post-processing adjustments selected on the 
Controls tab. Steps 1-3 must have already been successfully completed. 

• "Run complete RFP analysis": launches a sequence of runs using the entire 
progression of federal and state rules shown on the Control tab. 

• "Generate CDBs for NEI": generates a single CDB per county that matches EPA’s 
naming conventions and requirements for nonroad submittals for AERR/NEI. 

• QA 

o Automate: automatically run the QA checks1 at the appropriate stage of 
execution when the "Run all steps" button is clicked. 

o Abort if QA checks fail: abort execution if any of the QA checks fail during 
a scenario launched using the "Run all steps" button. 

o QA input database: manually initiate QA checks of the TexN2 input 
database, including any databases specified on the "Input database" tab. 

o QA CDBs: manually initiate QA checks of the CDBs. Step 1 (Create runs) 
must have already been successfully completed. 

o QA MOVES output: manually initiate QA checks of the MOVES-Nonroad 
outputs. Steps 1-4 must have already been successfully completed. 

 
1 ERG technical memo to the TCEQ. MOVES-Nonroad Model Utility for Adapting TexN Model Data for Use 
Within the US EPA MOVES Model: Task 8: Define Utility QA Functionality. August 17, 2018. 
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• MOVES and MySQL 

o MySQL user: a valid MySQL username. We recommend “moves”. 

o MySQL password: the password associated with the MySQL username. We 
recommend “moves”. 

o MySQL port: enter your MariaDB port number here. It is most likely either 
3306 or 3307. Refer to the previous section “Prerequisites” under “Setting 
up TexN2.2” for more information on how to find the port number that 
MOVES3 uses. 

o MOVES database: the name of the default MOVES3 database, e.g., 
movesdb20210209. 

o MOVES install path: The location of the MOVES installation, e.g., 
C:/Users/Public/EPA/MOVES/MOVES3.0 

o Launch MOVES workers: MOVES includes an option to run multiple 
workers in parallel to speed execution and reduce runtime. The number of 
workers is generally limited by the number of processors/cores/threads 
available on your machine. For example, a machine that has two cores 
with hyper-threading, i.e., with four apparent CPUs, will typically perform 
well with three workers – one apparent CPU for the MOVES master and 
one for each worker. Clicking the "Launch workers" button will spawn a 
new Windows Command Prompt window and automatically launch the 
workers. MOVES workers persist until they are manually shut down (e.g., 
using Control-C within the Command Prompt window to terminate the 
batch job), so workers only need to be launched once during a TexN2 
session. A typical workflow might be to launch TexN2 and then 
immediately launch the MOVES workers if they are not already running. 
The MOVES workers will idle in the background until they are needed.  
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Reports tab 

The Reports tab is used to generate reports in a variety of formats: PDF, Excel, comma 
separated value (CSV), and CERS XML for TexAER and EPA EIS gateway submissions.  

The pulldown menu at the top of the tab lists all of the completed TexN2 scenarios on 
the machine.  

The "Emission totals by:" section lists the standard emissions reports available, and the 
"Population and fuel consumption by:" section lists the standard population and fuel 
consumption reports.  

The Export formats sections lists the available output formats. PDF, Excel, and CSV 
formats will all contain the report types selected in the previous sections, whereas XML 
reports will all contain the same information regardless of which options were selected 
in the previous sections. 

Once the desired scenario, report types, and formats are selected, the "Generate reports" 
button is used to generate the reports and export them to the output directory specified 
in the Scenario tab. 
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Log tab 

The Log tab displays status, warning, and error messages. 
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Automated RFP in TexN2 

The “Automated RFP” functionality allows users to execute a full Reasonable Further 
Progress analysis for designated counties for a given analysis year. The user needs only 
to launch a single run, and TexN2 creates 10 individual scenarios, beginning with the 
first where emissions are uncontrolled. TexN2 then incrementally turns on controls, one 
at a time for scenarios 2 through 9. The ninth scenario is fully controlled in terms of 
engine technology but does not include fuel program effects. The tenth scenario includes 
the effects of both reformulated gasoline (RFG) in Houston and Dallas area counties, 
and Texas Low Emission Diesel (TxLED) fuel in the group of TxLED-affected counties. 
The list below outlines the chronology of the Automated RFP process in TexN2. The list 
uses the same abbreviations as TexN2, so it should be used in conjunction with the 
output reports from the “Automated RFP” to properly calculate the incremental 
emissions for each rule for an RFP demonstration. 

TexN2 “Automated RFP” scenario names in chronological order: 
1. smallSprk1_uncntl (This is the uncontrolled scenario.) 
2. smallSprk1_cntl 
3. Tier1_cntl 
4. Tier2_3_cntl 
5. smallSprk2_cntl 
6. largeSprk_cntl 
7. Tier4_cntl 
8. recMarine_cntl 
9. smallSI_cntl 
10. allRules_cntl  (This is the fully controlled scenario.) 

Setting up an Automated RFP Run 

Scenario Name 

Set a scenario name. In the scenario tab of the GUI, type in a scenario name. TexN2 
will use your entered scenario name to name everything associated with your run, 
including the final output reports. For example, providing a scenario name of “autorfp” 
would result in final output reports named: 

1. autorfp_smallSprk1_uncntl.xlsx (Uncontrolled) 
2. autorfp_smallSprk1_cntl.xlsx 
3. autorfp_Tier1_cntl.xlsx 
4. autorfp_Tier2_3_cntl.xlsx 
5. autorfp_smallSprk2_cntl.xlsx 
6. autorfp_largeSprk_cntl.xlsx 
7. autorfp_Tier4_cntl.xlsx 
8. autorfp_recMarine_cntl.xlsx 
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9. autorfp_smallSI_cntl.xlsx 
10. autorfp_allRules_cntl.xlsx (Fully controlled) 
 

Output Directory 

Set the output directory.  In the scenario tab, navigate to the directory where you 
would like the automated RFP analysis files to be stored. TexN2 will use your specified 
directory to organize all files associated with your run using the structure shown below. 
For an example directory of “C:\texn2\output”, TexN2 will automatically create 10 
subfolders named: 

11. C:\texn2\output\autorfp_smallSprk1_uncntl\  
12. C:\texn2\output\autorfp_smallSprk1_cntl\ 
13. C:\texn2\output\autorfp_Tier1_cntl\ 
14. C:\texn2\output\autorfp_Tier2_3_cntl\ 
15. C:\texn2\output\autorfp_smallSprk2_cntl\ 
16. C:\texn2\output\autorfp_largeSprk_cntl\ 
17. C:\texn2\output\autorfp_Tier4_cntl\ 
18. C:\texn2\output\autorfp_recMarine_cntl\ 
19. C:\texn2\output\autorfp_smallSI_cntl\ 
20. C:\texn2\output\autorfp_allRules_cntl\  

Run Selections 

Complete the scenario tab.  Choose a scenario year, met year, period, enter Author 
name and contact information, and any optional comments. 

Check all boxes in the upper panel of the Controls tab labeled `Post-Process 
and Fuels` without checking anything in the lower panel labeled `Emissions 
technology and RFP analysis`. The user selections for two buttons “TxLED” and 
“Reformulated gasoline” are ignored by TexN2 in an automated RFP analysis as they are 
hard-coded to switch off (for scenario 1-9) and then on (for scenario 10). User selections 
under `Emissions technology and RFP analysis` panel are ignored during an Automated 
RFP analysis because the 10 scenario setups are already hard-coded. Alternatively, this 
section could be used to prepare 10 separate runs for a manual RFP analysis. However, 
this document addresses the “Automated RFP” functionality process. 
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Next, fill out the `Region`, `Sources`, `Edit`, and `Input databases` tabs of 
the GUI as desired for your analysis. Most likely, you will not have reason to 
change anything in ‘Edit’ or ‘Input databases’ tabs, unless new data are available that 
have not already been loaded into the TexN2 database.   

In the Run tab, click “Launch workers” to start multiple MOVES workers (if 
applicable), then click “Run complete RFP analysis.” This will automatically 
take you to the `Log` tab of the GUI where you must wait until the 10 scenarios are 
complete.  
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Generate Reports from the Automated RFP Run 

Once the RFP analysis is complete, you will see a confirmation message from TexN2. 
Next, click on the `Reports` tab of the GUI. Select any desired reporting options for 
your reports. To generate the first report (1 of 10), use the drop-down menu to find the 
scenario name you provided at the beginning of the run. The screenshot below shows 
the set of reports available for a test run with scenario name ‘adb_test2_20180508.’ The 
10 control scenarios associated with the “Automated RFP” run appear in alphabetical 
order in the drop-down menu. The order in which the user exports results from the 10 
scenarios is not important, but it may be helpful to progress alphabetically because of 
their order of appearance in the menu. Select one, then click the “Generate reports” 
button. 
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You will need to wait several seconds to minutes (depending run size and output 
selection). When TexN2 completes the report, you will see a confirmation message 
window, similar to that shown below. Click “OK” and proceed to the next scenario until 
all 10 are complete. 

 

 
 

The output reports are organized according to the output directory structure shown 
previously.  
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RFP Delta Calculation 

The incremental emissions impacts associated with each rule can be determined by 
subtracting the values contained in each report from the prior report. For example, to 
calculate the benefits associated with the first rule, subtract the emissions in the second 
report (for smallSprk1_cntl) from those in the first report (for smallSprk1_uncntl). To 
calculate the benefits for the second rule, subtract the values in the Tier1_cntl report 
from the values in the smallSprk1_cntl report, etc. Total rule benefits can be calculated 
either by summing the incremental benefits for each rule, or by simply subtracting the 
values in the allRules_cntl report from the smallSprk1_uncntl report. 

• The Delta for Small Spark ignition I = (smallSprk1_uncntl) – (smallSprk1_cntl) 
• The Delta for Tier 1 Diesel = (smallSprk1_cntl) – (Tier1_cntl) 
• The Delta for Tier 2 & 3 Diesel = (Tier1_cntl) – (Tier2_3_cntl) 
• The Delta for Small Spark Ignition II = (Tier2_3_cntl) – (smallSprk2_cntl) 
• The Delta for Large Spark Ignition = (smallSprk2_cntl) – (largeSprk_cntl) 
• The Delta for Tier 4 Diesel = (largeSprk_cntl) – (Tier4_cntl) 
• The Delta for Diesel Recreational Marine = (Tier4_cntl) – (recMarine_cntl) 
• The Delta for Spark Ignition Marine = (recMarine_cntl) – (smallSI_cntl) 
• The Delta for All Rules = (smallSpark1_uncntl) – (allRules_cntl) 
• The Delta for TxLED and RFG = (smallSI) – (allRules_cntl) 

Although the benefits of TxLED and RFG are combined into a single run, their 
individual impacts can be understood by looking at the output fuel type ID (i.e., diesel 
for TxLED and gasoline for RFG). 
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Migrating from TexN 

Much of the layout of TexN2 was modeled after the TexN GUI, so the general flow of the 
GUI should be relatively familiar if you have experience with TexN. However, there are a 
few notable differences: 
 

• No custom scenario browser: TexN used a custom browser to list all of the TexN 
scenarios available on the machine, filter by date range, etc. TexN2, in contrast, 
uses a standard Windows file browser for saving, finding, and opening scenarios. 
Therefore, all of the standard Windows methods can be used for filtering, 
searching, and navigating to the TexN2 scenario configuration files. TexN2 
scenario configuration files are simple JSON files, and they can be saved in any 
location within the user's account, such as the Desktop, Documents folder, or 
other subfolder. 

• No separate Microsoft Access reporting utility: TexN relied on reports generated 
using Microsoft Access, whereas TexN2 has built-in reporting functionality. 

• No need to run as Administrator: on some machines, it was necessary to choose 
"Run as administrator" when launching TexN; this is not necessary for TexN2. 

• No need to restart the utility when loading a new scenario: some versions of TexN 
required the user to close and reopen the utility when specifying a new scenario; 
this is not necessary with TexN2.  

• No separate tabs for editing population, activity, fuel, and climate data: TexN2 
consolidates all of the editing functionality on a single tab, and the visible data is 
chosen using a pulldown menu. 

Migrating from TexN2 earlier versions 

The layout of TexN2.2 is nearly identical to TexN2.1 and TexN2.0.  The main change to 
be aware of with TexN2.2 is that it requires MOVES3 and will not run with 
MOVES2014b or earlier versions of MOVES.  TexN2.2 also requires the user to specify 
the database port connection (most likely 3306 or 3307), which is a change from prior 
versions of TexN2.  We recommend clearing out old TexN2 databases prior to loading 
the new one from TexN2.2.  This may be done through HeidiSQL by executing the query 
“DROP DATABASE IF EXISTS texn2;” without the quotation marks (be sure to 
include the semicolon) or by clicking on the ‘texn2’ database name listed in the left-pane 
inside HeidiSQL and selecting the option “Drop”. 
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Managing TexN2 and MOVES-Nonroad databases using 
HeidiSQL 

Both TexN2 and MOVES3 use MariaDB to store input, intermediate, and output data. 
The following sections explain how to use HeidiSQL (the replacement for MySQL 
Workbench) to perform some basic operations that are essential for using TexN2 
effectively. These sections assume that you have already successfully launched HeidiSQL 
logged in (see Importing the TexN2 database section above). 

Adding Data Developed in Outside Studies 

TexN2 was designed to handle replacing the Texas-specific data in the utility with other 
local data. The simplest way to replace TexN2 data with small amounts of local data is 
via the “Edit” tab of the TexN2 GUI.  Another way to replace larger amounts of data 
more quickly, is using the “Input databases” tab of the GUI.  The “Input database” tab 
approach is more labor intensive, because it requires creating MySQL data tables.  The 
“Edit” tab approach should be used for smaller data changes, while the “Input 
databases” tab approach is more convenient for changing larger amounts of input data. 
Refer to prior sections of this User Guide for more information: Edit tab and Input 
databases tab.  The following two screenshots shows an example of how to use the Edit 
tab to update the population of Welders 750-1,000 HP operating in Harris from zero (0) 
to 30 equipment.  The Edit tab below lists Harris county population for the SCC 
2270006025, with blue-shaded cells (which cannot be edited) and clear cells (editable). 
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Double-clicking inside the cell containing the “0.0” population transforms the value into 
empty space with a blinking cursor, and you may type in any value (30 equipment in 
this example), as shown below. 

 

 

Viewing and exporting raw data from TexN2 scenario databases 

After successful execution of a TexN2 scenario, the final output data will be stored in a 
MySQL database with the same name as the scenario name defined in the Scenario tab 
of the GUI. However, it may be necessary to refresh HeidiSQL so it displays recently-
added databases. The refresh icon is a single circular arrow overlaid onto a green circle. 
The refresh icon is available along the top menu, or also available from a right-click of 
your database connection name and click “Refresh” in the drop-down menu.  Both 
options are indicated with red arrows below. 

After refreshing the database list, you should see a number of databases related to the 
current scenario. The main database will have names of the form scenarioName, where 
scenarioName is the name specified in the Scenario tab of the GUI, with no additional 
suffixes. The CDBs will have names of the form scenarioName_countyID_runID, where 
countyID is the MOVES countyID and runID is an integer used to identify the multiple 
runs that are required to model multiple DCE subsectors. The MOVES-Nonroad output 
databases will have names of the form scenarioName_countyID_runID_out: 
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To view the data in a MySQL table, first expand the contents of the parent database by 
clicking the “>” symbol adjacent to the left of the database name. Next, expand the 
contents of the Tables item to display the names of the tables contained within the 
database. To display the contents of the table, click the table's name with your mouse. 
This should trigger a new “Data” tab to appear next to your “Query” tab. 
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When you click this icon, MySQL Workbench will automatically run a SELECT 
command to display the table's contents in the Result Grid. Note: by default, HeidiSQL 
will limit the results to 1,000 rows. To view the next 1,000 rows, click on the button 
“>> Next” or “Show all” for the full contents.  “Show all” can result in very long query 
execution times for larger tables. 
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You can export the results of your query by clicking on the Export icon above the query. 
Note: when you export data with this method, any row limits specified for the query 
will be in effect. For example, if the default 1,000 row limit were included, your 
exported data will only include the first 1,000 rows. To export the complete table, 
increase the maximum rows allowed in Tools > Preferences > Grid formatting, then 
select “Show all” on the table before running the “Export grid rows”. 
 

 
 
 
Deleting databases 

The databases generated by MOVES-Nonroad can require large amounts of storage 
space, so it is often necessary to delete existing databases to free up space on the 
machine. For example, once a scenario has run successfully and the data have been 
compiled into the scenario database and post-processed, you may want to delete all of 
the MOVES-Nonroad CDBs and the MOVES-Nonroad output tables associated with the 
scenario. You can delete databases one at a time in HeidiSQL by clicking each database 
in the left-hand pane, right-clicking, and choosing “Drop”.  If you need to delete a large 
number of databases, ERG recommends continuing to use MySQL Workbench to select 
a group of databases in the left-hand pane, right-click, and choose “Delete X Schemas…” 
as shown in the second screenshot below.  This will require the user to configure MySQL 
Workbench to connect to the MariaDB data directory following the instructions earlier 
in this User Guide (Setting up TexN2.2 > Configuring MySQL Workbench).  
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Screenshot of the HeidiSQL method to delete one database at a time: 
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Screenshot of the MySQL Workbench method to delete many databases at one time: 

 

Alternatively, you may reboot your computer (to refresh the MariaDB connection), 
navigate to your MariaDB data directory, and select the large number of databases, 
right-click, and choose “Delete” as shown below. 
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Troubleshooting 

If the TexN2 GUI crashes for any reason, information on the cause of the problem can 
often be found in the application log file, typically located at 
C:\Users\username\AppData\Local\ERG\TexN2.log, where username is the active 
user's account name. 
 
TexN2 relies heavily on MariaDB, and occasionally the MariaDB server is in a state that 
delays processing or precludes TexN2 from functioning normally. For example, under 
some conditions TexN2 can enter a deadlock condition where it is waiting for a database 
table to be released, or execution may be delayed due to MariaDB repairing a corrupted 
table. If TexN2 appears to be frozen or is taking longer than normal to execute, insight 
into the root cause may be gained by running the "show processlist;" command 
from within HeidiSQL and looking for States such as "Waiting for table level lock" or 
messages related to repairing tables, sorting, etc. The steps required to resolve a 
particular issue will depend on the details of the condition being reported and the 
current context. 
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